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Printing History
Printing History

The manual printing date and part number indicate its current edition. 
The printing date will change when a new edition is printed. Minor 
changes may be made at reprint without changing the printing date. The 
manual part number will change when extensive changes are made. 

Manual updates may be issued between editions to correct errors or 
document product changes. To ensure that you receive the updated or new 
editions, you should subscribe to the appropriate product support service. 
See your HP sales representative for details.

Table 1 Publication Dates

Edition Publication Date

First June 2001

Second February 2002

Third April 2002
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Conventions
Conventions

The following typographical conventions are used in this manual.

Table 2 Documentation Conventions

Font 
Type

What the Font Type 
Represents Example

Italic Book or manual titles Refer to the HP OpenView Smart 
Plug-in for mySAP.com 
Installation Guide for more 
information

Provides emphasis You must follow these steps.

Specifies a variable that 
you must supply when 
entering a command

At the prompt type: 
rlogin your_name 
where your_name is the 
name you use to log in.

Parameters to a function The oper_name parameter 
returns an integer response.

Bold New terms The monitor agent observes...

Computer Text on the computer 
screen

The system prompts: Press
Enter

Command names Use the copy command...

Function names Use the opc_connect() function 
to connect ...

File and directory names c:\opt\OV\bin\OpC\

Process names Check whether the monitor 
agent, opcmona, is running

Window/dialog box names In the Add Logfile window...
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Conventions
Computer
Bold

Text that you must enter At the prompt, type: 
dir *.exe

Keycap Keyboard keys Press Return

[Button] Buttons on the user 
interface.

Click [Operator]
Click the [OK] button

Menu
Items

A menu name followed by 
a colon (:) means that you 
select the menu, then the 
item. When the item is 
followed by an arrow (->), 
a cascading menu follows.

Select
Actions:Utilities >
Reports…

Table 2 Documentation Conventions (Continued)

Font 
Type

What the Font Type 
Represents Example
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Documentation Road Map
Documentation Road Map

This section shows exactly what product-specific information is available 
with the HP OpenView for Windows Smart Plug-in for mySAP.com, in 
what form, and where you can find it. 

The HP OpenView for Windows SPI for mySAP.com provides a 
comprehensive on-line HELP system as well as product information in 
.pdf format with the aim of helping you improve your understanding of the 
product’s underlying concepts. The following SPI for mySAP.com 
documentation may be found on the product CD.

• HP OpenView Smart Plug-in for mySAP.com Configuration Guide

• HP OpenView Smart Plug-in for mySAP.com Administrator’s Reference

• HP OpenView Smart Plug-in for mySAP.com Software README

Table 3 on page 14, “Smart Plug-in for mySAP.com Documentation 
Roadmap,” provides a comprehensive overview of the documentation 
supplied with the SPI for mySAP.com’s related products.

HP OpenView Performance (OV Performance) Console documentation 
is only available on-line. For more information, select the Help menu 
item within the main OV Performance window.
13



Documentation Road Map
<AsIsBurgandy>Table 3, “SPI Plug-in for mySAP.com Documentation 
Roadmap,” on page 14 lists the manuals that are available with the 
products that are related to the Smart Plug-in for mySAP.com.

Table 3SPI Plug-in for mySAP.com Documentation Roadmap

HP OpenView 
Product Name Manual Title

for Windows Concepts Guide
Installation Guide
Installation Overview
Administrator’s Reference

Performance Agent Dictionary of Operating System Performance 
Metrics

Performance Agent Installation and System Management Guide
Data Source Integration Guide
Tracking your Transactions
Users Manual

Navigator Concepts and Configuration Guide

Smart Plug-in for 
Databases

DB-SPI Oracle Reference
DB-SPI Release Notes
DB-SPI Users Guide
14
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Introduction

This section gives an overview of the SPI for mySAP.com, describes how it 
is integrated with other HP OpenView products, and shows how easy it is 
to customize.

What is the Smart Plug-in for mySAP.com? 

The HP OpenView Smart Plug-in for mySAP.com is a software packages 
linking SAP R/3 to HP OpenView Operations and, in addition, to the 
OpenView Performance Console via the OpenView Performance agent. 
The union offers a complimentary and consolidated view of SAP R/3 
performance information and overall resource characteristics.

Please note that this chapter refers to both the SPI for mySAP.com for 
OVO Unix and OVO Windows. In some cases the terminology might 
not totally apply to both OVO management platforms.

References to both the new and (occasionally) the old product names 
appear in this book. For example, OpenView Operations (OVO) was 
previously known as IT/Operations (ITO). The OpenView Performance 
Console was previously PerfView. The OpenView Performance agent 
was formerly the MeasureWare agent.
15



Chapter 1: Introduction
This integration allows correlation of SAP R/3 performance data with the 
performance data of the operating system, the database, and the network 
—all from one common tool and in one central management system. 
Integration of SAP R/3 performance data into PerfView/MeasureWare 
helps to detect and eliminate bottlenecks in a distributed environment. In 
addition, the integration allows for system optimization as well as service 
level monitoring. The HP OpenView Smart Plug-in for mySAP.com offers 
the following key benefits:

• centralized problem management using OVO agents on the SAP R/3 
managed nodes. The use of the central OVO management server avoids the 
duplication of administrative effort.

• real-time event and configuration information—including useful on-line 
instructions—for fast problem resolution.

• powerful monitors for the detection of potential problem areas and keep 
track of system and R/3 events.

• performance data collectors to ensure system throughput and notify of any 
performance bottlenecks.

• direct, context-sensitive access to the SAP front-end.

• complements SAP R/3 Computing Center Management System (CCMS).

• performance data collection, monitoring, and reporting.

• central data repository for the storage of event and action records for all 
SAP R/3 managed nodes.

• utilities for running routine SAP R/3 management tasks.

• SAP service discovery and integration of SAP R/3 environments with HP 
OpenView Navigator—the SPI includes an application that will 
automatically generate service views of the SAP R/3 systems installed on 
your managed nodes.

What Does the SPI for mySAP.com Provide?

The SPI for mySAP.com provides the following capabilities for managing 
your SAP R/3 system:

• “Availability Management” on page 17.
16



What Does the SPI for mySAP.com Provide?
• “Performance Management” on page 19.

• “Service Reporting” on page 21.

• “Combined Availability and Performance Management” on page 22.

•  “Integration with OVO” on page 23.

Availability Management

This lets you know when something in your R/3 environment is going 
wrong. Maybe a disk is too full, or a key process has stopped prematurely 
or failed to start at the appropriate time. The combination of the SPI for 
mySAP.com and OVO alerts SAP administrators to such conditions. When 
the alert is given, the following additional assistance may be provided:

• Advice on corrective action that should be taken.

• A pre-defined action that the administrator can initiate.

• An automatic action, such as an e-mail message to a manager if a critical 
condition occurs.

The SPI for mySAP.com interfaces with CCMS, which monitors 
availability issues with R/3. Therefore, the SPI for mySAP.com is aware of 
any availability problems identified by CCMS. In addition it monitors over 
70 R/3 related conditions in the overall environment. When problems 
occur, the SPI for mySAP.com can call on over 40 UNIX®, Windows NT®, 
and SAP management tools to quickly fix things. 

Availability management monitoring includes:

• CCMS alert monitoring, including:

— ABAP/4 database events

— R/3 instance buffer problems

— Tracing information

— Enqueue server messages

— R/3 general messages

— Rolling and paging activities

— Internal R/3 database events
17



Chapter 1: Introduction
— Configuration status information

— Syslog messages

• Syslog monitoring

Either via CCMS syslog alerts or by direct monitoring of the SAP syslog via 
the XMI API. 

• Batch job monitoring

— Aborted jobs

— Long-time running jobs

— Jobs that failed to start 

• Process monitoring

Monitoring of all processes and conditions associated with an instance

• File monitoring

Monitoring relevant external files for SAP R/3 (log files, trace files)

• Monitoring SAP R/3 status and events via SPI ABAP modules. Status and 
events include:

— Change of system operating mode

— SAP locks

— ABAP/4 dumps

— Work process availability

— Work processes modes (debug, private, no restart)

— System change options

— TemSe consistency

— ALE monitoring

Managing from a Business Perspective

Using the OV Service Navigator, you can view the impact of events that 
trigger messages in the browser in a graphical format that makes you 
immediately aware of the business impact of lower level component 
failures or performance degradations.
18



What Does the SPI for mySAP.com Provide?
Using OV Service Navigator, you can get quickly to the root cause of a 
service failure, by simple point and click navigation to faulty components 
for further diagnosis and problem resolution.

The SPI for mySAP.com can perform service discovery. This automatically 
generates a service view that shows your SAP R/3 environments from a 
technical perspective. You can use the components of this service view and 
other OVO service views as building blocks to create Line-of-Business 
views that reflect the impact of events, occurring in SAP R/3 and the 
supporting infrastructure, on your business.

Performance Management

Performance management tells you about slowdowns that may be 
frustrating end-user productivity within your SAP R/3 environment. The 
combination of the SPI for mySAP.com, MeasureWare agents, and the HP 
OpenView PerfView metrics analyzer/viewer alerts SAP administrators to 
such conditions. 

This offers a complementary and consolidated view of SAP R/3 
performance information and overall system resource characteristics. 
These fully integrated HP OpenView products allow correlation of SAP R/
3 performance metrics with a variety of other performance data such as 
metrics for operating systems, databases, and networks. 

This detects and eliminates bottlenecks in a distributed environment. In 
addition, the integration allows for system optimization as well as service 
level monitoring, resulting in improved user productivity and maximum 
return on investment. 

The SPI for mySAP.com monitors the following SAP R/3 metrics:

• Dialog task frequency, response time, and wait time. 

• Update task frequency, response time, and wait time.

• Batch task frequency response time, and wait time.

• Spool task frequency, response time, and wait time.

• Work-process number, type, and status.

• Job statistics and state.
19



Chapter 1: Introduction
• End-to-end transaction times (with 4.6 only).

• Spool and print jobs.

Monitoring SAP Internet Transaction Server (ITS)

The SAP ITS server comprises two main components, the Application 
Gateway (Agate) and the Web Gateway (Wgate) as illustrated in “ITS 
Architecture” on page 21. Both these components can be monitored by the 
ITS performance monitor, which is installed by the SPI for mySAP.com.

The SPI for mySAP.com now includes a dedicated SAP ITS (Internet 
Transaction Server) monitor, which allows you to:

• check the availability of the various components of the ITS server, 
including; AGate, WGate, and Web Server.

• pinpoint communication problems between the ITS components even in an 
environment with multiple ITS instances and complex load sharing.

• collect important SAP R/3 performance metrics, which can be used in 
conjunction with other system or application performance data to identify 
bottlenecks and long term performance trends.
20



What Does the SPI for mySAP.com Provide?
Figure 1 ITS Architecture

The collected data can then be used with OpenView performance tools 
such as the OpenView Reporter or OpenView Performance to investigate 
problems and general performance issues.

Service Reporting

The SPI for mySAP.com includes a predefined set of service reports. 
Service reports are web-based reports that are produced by HP OpenView 
Reporter (OV Reporter) using Crystal Reports templates and viewed using 
a web browser. OV Reporter allows you to request both scheduled and on-
demand versions of reports.

ITS

Web
Server WGate

SAP R/3
System

SAP R/3
System

AGate

Web
browser

http tcp/ip SAP GUI rfc
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Chapter 1: Introduction
SPI for mySAP.com service reports corollate the data extracted from 
either the OVO Embedded Performance Agent (Coda) or the OpenView 
Performance agent (formerly MeasureWare). You can use the correlated 
data to generate reports which display short-, medium-, or long-term 
views of your IT environment and supplement the detailed, real-time 
graphs available with PerfView. 

Combined Availability and Performance Management

When using both the availability and the performance management 
capabilities, performance alarms can be automatically forwarded to an 
SAP administrator. The SAP administrator can then start HP OpenView 
PerfView to view the performance problem directly. This consolidated 
approach allows availability and performance problems to be managed in 
a consistent, fast, and efficient way. 
22
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Integration with OVO

At the heart of the SPI for mySAP.com is a set of monitors (data collectors) 
which are designed to make checks on different aspects of SAP R/3 system 
health. The SPI for mySAP.com includes the following monitors:

The SPI monitors are completely integrated into OVO, both in their 
configuration and distribution, as well as in the day-to-day tasks of 
receiving messages and taking action to resolve problems. This section 
also discusses the following topics:

•  “Configuration and Distribution Concepts” on page 24.

•  “Messages and Actions” on page 26.

CCMS ALERT collects alerts from the SAP R/3 internal monitor, the 
CCMS alert monitor.

Syslog collects messages from the SAP R/3 syslog. 

Jobs identifies SAP R/3 batch jobs that are in an abnormal 
state; for example, aborted jobs.

Processes reports on the availability of SAP R/3 work processes and 
database processes at operating system level.

Files reports on errors in the SAP R/3 trace and log files.

SPI ABAP modules which carry out monitoring tasks within SAP R/
3, for example; checks on SAP processing modes, SAP 
dumps, the availability of work (and other) processes.
23



Chapter 1: Introduction
Configuration and Distribution Concepts

For the purposes of configuration and distribution, the SPI for mySAP.com 
monitors have two points of integration to OpenView Operations, namely:

1 The SAP R/3 SPI message source template group. Distributing templates 
to managed nodes also distributes global configuration files for the moni-
tors and then, from the same location, the monitors themselves.

2 The Admin R/3 SAP and Admin Local R/3 SAP application groups 
which include applications for the configuration and distribution of global 
and local configurations, respectively. 

Figure 2 Global Configuration Concept 

The procedure for global configuration distribution shown in Figure 2 
differs according to whether you are using SPI for mySAP.com or SPI for 
SAP R/3 for Windows, as described on the following page:
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Procedure for global configuration

1 You edit the configuration file using the appropriate Admin R/3 SAP appli-
cation. This configuration can include definitions that apply to systems on 
multiple SAP R/3 servers.

2 The edited configuration file is transferred to the OVO distribution 
database in /var/op/OV/share/databases/OpC/mgd_node

3 The newly defined global configuration is distributed to the managed 
nodes via OVO template distribution or via the Install Config 
application.

Figure 3 Local Configuration Concept 

The procedure for local configuration distribution illustrated in Figure 3 
differs according to whether you are using SPI for mySAP.com or SPI for 
SAP R/3 for Windows, as described below:

1 You edit a configuration file for each node that has local configuration 
using the appropriate Admin Local R/3 SAP application. This configu-
ration includes definitions that apply only to a selected node. Each config-
uration file is stored in a directory on the management server, specific to 
configurations for the selected node.
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2 Each local configuration is copied to its target node.

Messages and Actions

The day-to-day monitoring of the SAP R/3 systems by the SPI for 
mySAP.com monitors is completely integrated with the facilities offered by 
OVO. 

The conditions identified by the monitors are passed to the OVO agent on 
the managed node. Conditions are compared to conditions defined in the 
message-source templates, and matching conditions are forwarded to the 
management server. Messages from the monitors are assigned to SAP-
specific OVO message groups, which are added to OVO when the SPI for 
mySAP.com is installed. These groupings of messages allow you to easily 
assign responsibility for SAP-related messages to selected operators. 

Messages that are sent to the management server are displayed in the 
OVO message browser. The full range of OVO message facilities are 
available for SPI for mySAP.com messages, including differentiation of 
messages according to severity, detailed description of the condition and 
advice on problem resolution, and pre-defined operator-initiated and 
automatic actions. 
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Figure 4 Message Flow between SAP R/3 and OVO 

The sequence of events within the OVO message flow phase is as follows:

1 An event occurs on an object that is being monitored by one of the collec-
tors, and a message is created as a result, for example, a batch job aborts. 

2 The OVO agent on the managed node receives the message. 

3 The message is compared to filters. Messages matching suppress 
conditions or duplicate messages are suppressed. Other messages are 
forwarded.

4 Messages matching filters are converted to the OVO message format, and 
forwarded to the management server. 

5 The active message is stored in the database. 

6 The message is displayed in the message browser window for operators 
who have responsibility for the appropriate message group and managed 
node.
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7 The message can now be selected and any operator-initiated actions that 
are defined can be started. An operator-initiated action can be:

• Remote Function Call, which starts an ABAP program to solve the 
problem or to gather information about the environment. The 
information is appended to the message as an annotation.

• opening the SAP GUI if, for example, a job aborts. The related 
message could have an operator-initiated action which calls the job-
overview transaction and displays it in the SAP GUI.

8 When the message is acknowledged, it is removed from the active 
database and put into the history database for better statistics or other 
analysis.
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Easy Customization 

This section explains how you can customize the flow of messages from 
SAP R/3 to OVO in both the SAP R/3 environment and VPW, as described 
in the following two sections:

• “Customization on the SAP R/3 Side” on page 29.

• “Customization on the OVO Side” on page 29.

Customization on the SAP R/3 Side 

• Enable or disable SAP R/3 client groups so that these are tracked or not 
tracked in the CCMS alert monitor. This method is discussed in the HP 
OpenView Smart Plug-in for mySAP.com Administrator’s Reference.

— Enabled messages cause a CCMS alert to be created, which can then be 
identified by the SPI for mySAP.com CCMS alert monitor and 
forwarded to the OVO management server.

— If a message is disabled in the CCMS alert monitor, there will be no 
internal SAP R/3 CCMS alert, so there will also be no OVO message.

• Set thresholds for the inclusion of alert messages in the SAP R/3 CCMS 
alert monitor. This method is discussed in the HP OpenView Smart Plug-in 
for mySAP.com Administrator’s Reference.

• Set up selected alert messages so that they are included in the SAP R/3 
system log file. This method is discussed in the HP OpenView Smart Plug-
in for mySAP.com Administrator’s Reference.

Customization on the OVO Side 

• Use powerful monitors to tune the control of your distributed SAP R/3 
environment. For details see the HP OpenView Smart Plug-in for 
mySAP.com Administrator’s Reference.

• Apply filters to display only the relevant types of messages. This method is 
documented in the HP OpenView Smart Plug-in for mySAP.com 
Administrator’s Reference.
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• Change the severity of messages in accordance with your specific 
requirements. This method is documented in the HP OpenView Smart 
Plug-in for mySAP.com Administrator’s Reference.
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Software Installation

This section provides the information you need to install the Smart Plug-
in for mySAP.com (SPI for mySAP.com) software.

Before You Begin

Before starting to install version B.08.00 of the SPI for mySAP.com:

• Ensure that your system meets all requirements, as detailed in the 
following sections:

— “Hardware, OS, and Disk Space Requirements” on page 33.

— “Compatible Software Versions” on page 34.

• For each SAP R/3 instance, note:

— which SAP R/3 version is installed

— whether SAP R/3 is installed on a central instance or an application 
server

• Create a list of all the SAP clients to monitor. For each client, list the 
following data:

— Hostname of the SAP application server

— SAP system ID

— SAP Instance number
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— SAP client number

— Operating system platform (UNIX or NT)

You will use this information to set up the environment configuration file 
for the Smart Plug-in for mySAP.com.

Requirements

This section lists the system requirements for the installation of the SPI 
for mySAP.com and comprises the following sections:

• “Hardware, OS, and Disk Space Requirements” on page 33.

• “Compatible Software Versions” on page 34.
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Hardware, OS, and Disk Space Requirements

Before you install version B.08.00 of the SPI for mySAP.com, use the 
information provided in Table 1 to ensure that your systems (management 
server and managed nodes) meet the hardware, operating system, and 
disk space requirements. For information on which managed node 
platforms are supported by the Smart Plug-in for mySAP.com B.08.00, see 
Table 3.

Table 1 Hardware, OS, and Disk Space Requirements

Product Hardware OS Minimum 
Disk Space

Smart Plug-in for 
mySAP.com on the 
management server

Intel Windows 2000b 
Server Edition or 
Advanced Server 
Edition

200MB

Smart Plug-in for 
mySAP.com on managed 
nodes

HP 9000 
Series 800 
running:

HP-UX 10.20

40MB

HP-UX 11.0/11ia

IBM RS/6000 AIX

Intel Windows NT

Windows 2000b

Sun SPARC Solaris

a Although it is planned to use "HP-UX 11i" in the future to describe a 
whole family of HP-UX 11.xx releases, today HP-UX 11i is commonly 
used as a synonym for HP-UX 11.11.

b The correct version of the MSVCRT.dll file must be installed to ensure that 
the configuration file deployment to the managed node is successful. Download 
and run the VC6RedistSetup_enu.exe self-extracting executable file. The 
executable is available at the following URL: 
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q259403
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Compatible Software Versions

Before you configure (or upgrade to) version B.08.00 of the SPI for 
mySAP.com, use the information provided in Table 2 and Table 3 to ensure 
that you are using a version of OpenView Operations (OVO) which is 
compatible with version B.08.00 of the Smart Plug-in for mySAP.com. In 
addition, you will need to ensure that:

• You are using a version of OVO which is compatible with version B.08.00 of 
the SPI for mySAP.com.

• OVO server and agent software are installed on the OVO management 
server.

• the standard, OVO management-server templates are assigned and 
distributed to the OVO management server.

• OpenView Reporter is available to view service reports for SAP R/3, SAP R/
3 performance, and ITS Performance Monitor data.

• For Performance Agent functionality (see also the HP OpenView Smart 
Plug-in for mySAP.com Administrator’s Reference Online Help):

— OpenView PerfView/Performance is installed on the management 
server.

— OpenView Performance agent software is installed on all the SAP 
application servers you wish to monitor.

— The HP OpenView SMART Plug-In’s DSI-to-DDF wrapper utilities are 
installed on the OVO management server:

# DSI2DDF X.X.X HP OpenView Smart Plug-Ins DSI-to-DDF
wrapper utilities.

Table 2 lists the software version for the OVO management server that is 
supported by the Smart Plug-in for mySAP.com B.08.00. 

Table 2 Supported OVO Management-Server Platforms

Product Version OS Platform

OpenView Operations A.07.00 Windows 2000 
Professional Server 
Edition
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Table 3 shows details of which versions of SAP R/3 and which OVO 
managed-node platforms are supported by the SPI for mySAP.com 
B.08.00. For information about the versions of other related software 
supported by the Smart Plug-in for mySAP.com B.08.00, see the SPI for 
mySAP.com README file.

Table 3 Supported Managed Node Platforms and SAP R/3 Versions

Managed Node OS
SAP R/3 Version a

3.1Ib 4.0B 4.5B 4.6B 4.6C 4.6Da 6.10

AIX 4.3.2 b • • • • • • •

AIX 4.3.3 • • • • • • •

HP-UX 10.20 • • • • • • •

HP-UX 11.00, 11i c • • • • • • •

Solaris 7 • • • • • • •

Solaris 8 • • • • • • •

Windows NT 4 d • • • • • • •

Windows 2000 • • • • • • •

a. According to SAP, 4.6D is not a complete SAP R/3 release, but a downward-com-
patible kernel, which is intended to be used mainly by other components of
mySAP.com. The 4.6D kernel is e.g. shipped with the R/3 4.6C Service Release 1.
b. 32 bit only.
c. Although it is planned to use "HP-UX 11i" in the future to describe an entire family of HP-
UX 11.xx releases, today HP-UX is commonly used as a synonym for HP-UX 11.11.
d.Service Pack 4 (or higher).

Version B.08.00 of the SPI for mySAP.com supports full SAP R/3 
versions, Business Warehouse (B/W), and APO systems. It does not 
support specific B/W and APO functionality.
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Configuration Overview

The complete configuration of the SPI for mySAP.com comprises three 
distinct phases, performed in the following sequence:

The software configuration phase described in detail in this chapter 
includes the following tasks:

1 “Configuring the Smart Plug-in for mySAP.com Software”  beginning on 
page 37.

2 “Verifying the Installation of the Smart Plug-in for mySAP.com Software”  
beginning on page 39.

3 “Installing the SAP R/3 GUI”  beginning on page 41.

Configuration... Description...

Phase 1: “Software Installation”  beginning on page 31.

The InstallShield Wizard installs the SPI for 
mySAP.com software on the OVO management server. 
The next step is to configure and set up the SAP R/3 
GUI for windows.

Phase 2: “Configuration: OVO Administration Tasks”  
beginning on page 43.

You integrate the SPI for mySAP.com with OVO and 
bring all SAP application servers under OVO 
management.

Phase 3: “Configuration: SAP-Specific Tasks”  beginning on 
page 55.

You set up an SAP user and the SAP transport for the 
SPI for mySAP.com and configure the SPI monitors 
according to the monitoring requirements of your 
environment.
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 Configuring the Smart Plug-in for mySAP.com 
Software

This section describes how to configure the SPI for mySAP.com software 
on the OVO management server.

Before you Begin

Before you configure the SPI for mySAP.com, the HP OpenView 
Operations for Windows 7.0 (OVO for Windows) CD-ROM must be 
installed (PN# B7490-13034/15034). Once OVO for Windows has been 
installed use the hp OpenView operations for Windows - SMART plug-ins 
CD-ROM (PN# B7490-13036/15036) to install the SPI for mySAP.com. 

For more information on installing hp OpenView operations for Windows - 
SMART plug-ins CD-ROM, see the HP OpenView Operations Performance 
for Windows Installation Guide.

Configuring the SPI for mySAP.com software

1 From the Windows Start menu browse to the following:

Settings > Control Panel > Add/Remove Programs.

2 Select HP OpenView Operations Performance for Windows.

3 Select Change.

4 Select Install products.

If you installed the SPI for mySAP.com software at the same time you 
installed the HP OpenView Operations 7.0 for Windows software, 
proceed to “Verifying the Installation of the Smart Plug-in for 
mySAP.com Software” on page 39.
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5 When the InstallShield Wizard dialog box displays, select 
mySAP.com. by placing a check mark in the box as illustrated in Figure 
1.

Figure 1 InstallShield Wizard Dialog Box

6 From the Product Selection Install Wizard dialog box, follow the 
on-screen instructions.

7 Before continuing with the configuration of the SPI for mySAP.com 
software ensure the installation process completed correctly by following 
the instructions listed in “Verifying the Installation of the Smart Plug-in 
for mySAP.com Software” on page 39.
38



Verifying the Installation of the Smart Plug-in for mySAP.com Software
Installing the mySAP.com Report Package

The SPI for mySAP.com report package includes a component that must 
be installed on the Windows system running OpenView Reporter. The 
purpose of the component is to establish a connection between OpenView 
Reporter and OpenView Operations.

Installing the SPI for mySAP.com database for OpenView Reporter

1 Insert Disk 2 hp OpenView operations for Windows - SMART plug-ins disk 
(PN B7490-13035/15035) into the CD-ROM drive of the OpenView 
Reporter system. 

2 Run the following program to install the report package for the database 
type:

• sapspi_reporter.msi

3 From the Reporter status pane verify changes to the Reporter 
configuration including uploading mySAP.com policies.

4 The mySAP.com reports are automatically assigned to the ALL group in 
the main window of Reporter.

5 Add group and single system reports by assigning reports as desired.

Verifying the Installation of the Smart Plug-in for 
mySAP.com Software

It is recommended that you carry out a number of simple checks to verify 
that the installation of the SPI for mySAP.com software is completed 
successfully.

Verifying the installation

1 In the OVO console tree, browse to the following item:

Complete the procedure below only if you have installed the full 
version of OpenView Reporter without installing HP OpenView 
Operations for Windows 7.0 (OVO for Windows).
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Tools > SPI for mySAP.com

Check the that the following sub-directories are present and, by : 

• SAP R/3 Admin

• SAP R/3 NT

• SAP R/3 UN*X

2 Clicking each sub-directory to confirm tools are present as illustrated in 
Figure 2.

Figure 2 SPI for mySAP.com tools sub-directory

3 In the OVO console tree, browse to the following item:

Policy management > Deployment packages

a The following items (belonging to the ConfigFile policy type) should be 
present as illustrated in Figure 3.

• ConfigFile policy package for Windows Nodes
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• ConfigFile policy dummy package for UNIX Nodes

Figure 3 Checking the Installed Packages

Installing the SAP R/3 GUI

Next, you need to install the SAP GUI on the OVO management server as 
well as on the machines where you want to run a OVO console. You should 
use your SAP installation CD to install the most recent version of the SAP 
GUI available in your environment. Note that most of the operator-
initiated actions and tools included in the Smart Plug-in for mySAP.com 
have to start the SAP GUI. For this reason, a SAP GUI must be installed 
on the OVO management server. This section explains how to install the 
SAP R/3 GUI 4.6 for Windows 

Installing the native GUI for SAP R/3 4.6

1 Insert the SAP R/3 presentation CD for Windows in the drive and browse 
to the following directory:

<CDROM>:\GUI\Windows\Win32
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2 Run the Setup.exe command and follow the instructions displayed by 
the installation wizard.

3 To start the SAP R/3 GUI, you will have to create a new SAP GUI logon 
using the following menu sequence: 

Start:Programs > SAP Frontend > SAPlogon

4 Click the [New...] button to display the window illustrated in Figure 4. 
Use the appropriate fields to enter a description and the name of the 
server to which you want to connect and click [OK]. The value you enter in 
the Description field appears later in the list of servers in the SAP
Logon window.

Figure 4 Starting the SAP R/3 GUI for Windows

5 In the SAP Logon window, select the server to which you want to connect 
and click the [Logon] button.

Once the setup has completed and before continuing with the 
installation of the Smart Plug-in for mySAP.com, we recommend 
you test the SAP GUI installation by attempting to start it 
manually.
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Configuration: OVO Administration 
Tasks

In this section you set up the SPI for mySAP.com.

Overview

In this phase of the SPI for mySAP.com configuration, you use the OVO 
administrator GUI to integrate the SPI for mySAP.com with OVO and 
bring all SAP servers under OVO management. In this section, you 
complete the following tasks:

1 “Deploying OVO Components to SAP R/3 Nodes” on page 44.

2 “Configuring the Smart Plug-in for mySAP.com Monitors” on page 46.

3 “Deploying Smart Plug-in for mySAP.com Policies to SAP R/3 Managed 
Nodes” on page 48.

4 “Specifying SAP R/3 Systems to Monitor” on page 52.
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Deploying OVO Components to SAP R/3 Nodes 

The deploy instrumentation command deploys the contents of the actions, 
commands, and monitors directories to the selected SAP R/3 managed 
nodes. If the actions, commands, and monitors are not deployed, the SPI 
for mySAP.com features and functionality will not work as expected. The 
directories containing the actions, commands, and monitors usually reside 
in the following location: 

C:\Program Files\HPOpenView\Instrumentation\
<OS Name>\<OS Version>\

where <OS Name> is the name of the operating system running on the 
OVO managed node.

The tasks in this section assume that the SAP R/3 systems you want to 
monitor with the SPI for mySAP.com are already OVO managed nodes. 
If this is not the case, see the OVO on-line help for instructions that 
explain how to add managed nodes to OVO.

If the SAP R/3 systems to which you want to deploy theSPI for 
mySAP.com components do not appear in the OVO console, see the 
OVO on-line HELP for instructions about adding managed nodes to 
OVO.
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To deploy the OVO instrumentation:

1 In the OVO console, select and right-click the SAP R/3 (managed node) 
system you want to deploy the SPI for mySAP.com components on.

2 From the drop-down menu, select the following menu option:

All Tasks > Deploy Instrumentation

a When the Deploy Instrumentation box appears select the 
following 

Action

Command

Monitor

SPI for mySAP.com Discovery

SPI for mySAP.com Performance Package as illustrated in Figure 1 
below:

Figure 1 Deploy Instrumentation Dialog Box

You can monitor the deployment as it happens in the 
Deployment Jobs window.
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3  Click OK.

For more information about the options for installing and updating 
software, see the on-line help for OVO administrators.

Configuring the Smart Plug-in for mySAP.com 
Monitors

The SPI for mySAP.com monitors you deploy to the SAP R/3 servers that 
are managed by OVO require information about what to monitor and how. 
The monitors obtain this information from default configuration files, 
which are installed by the Smart Plug-in for mySAP.com. Each of the SPI 
for mySAP.com monitors has its own default configuration file.

In this step you use the configuration-file policy editor to edit global 
configuration files (from the default files) for each of the SPI for 
mySAP.com monitors which run on the SAP R/3 servers. Once you have 
edited the configuration files, you deploy them to the SAP R/3 servers 
using the standard OVO policy-deployment mechanism.

To modify an existing configuration-file policy for the Smart Plug-in for 
mySAP.com monitors

1 In the OVO console tree, browse to the following directory: 

Policy Management > Policy Groups > SPI for mySAP.com

2 In the details pane, locate and double-click each configuration file 
associated with the monitor you want to configure, for example; the 
global_r3itosap file. The configuration-file policy editor displays the 
selected file as illustrated in  Figure 2 on page 47.

3 All other global configuration files can be used in their default state. In 
the event that you want or need to modify them, scroll down to the end of 
the Configuration File content box, there you will find the alert definitions 
and can make any changes as required.

The r3itosap.cfg file contains the SAP login information 
that suits the requirements of your SAP R/3 environment, this 
is the only global configuration file that must be edited.
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4 Save your policy and exit the ConfigFile policy editor. When saving the 
policy, we recommend you use the configuration-file policy type naming 
conventions, for example: global_r3mondmp. For local configurations, we 
recommend you replace global with the name of the SAP R/3 server for 
which the local configuration is intended, for example; 
<SAP_server_name>_r3mondmp

The modified configuration-file policy for the SPI for mySAP.com 
r3mondmp monitor appears in the list of policies in the details pane.

5 Deploy the modified configuration-file policies to the SAP R/3 managed 
nodes as described in “Deploying Smart Plug-in for mySAP.com Policies” 
on page 51 in  Figure 4 on page 51.

Figure 2 Editing the r3itosap.cfg File
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Deploying Smart Plug-in for mySAP.com 
Policies to SAP R/3 Managed Nodes

Non-configuration policies for the SPI for mySAP.com are organized into 
five default groups, all of which are part of the policy group SPI for
mySAP.com. The Smart Plug-in for mySAP.com policy groups are:

• mySAP.com ITS

• SAP R/3 3.1I AppServer

• SAP R/3 3.1I Central Instance

• SAP R/3 4.x AppServer

• SAP R/3 4.x Central Instance

Only one policy group should be assigned to any one managed node. Which 
policy group you assign is determined by the version of SAP R/3 running 
on the managed node and whether the node is a central instance or an 
application server.

The SPI for mySAP.com default policy groups contain all the SAP R/3 
monitors supplied with the Smart Plug-in for mySAP.com. Deploying a 
policy group automatically activates the monitors, which the group 
contains.

To avoid receiving messages from unnecessary or unwanted monitors

1 Make copies of the default policy groups and modify the copies to create 
your own policy groups containing only those monitors and policies you 
need.

Remember to deploy an alert monitor’s configuration-file policy before 
deploying the corresponding alert monitor itself. The alert monitors 
read these configuration files on startup. For example, you need to 
deploy the global_r3moncts configuration-file policy before you 
deploy the corresponding alert monitor, r3moncts. for more 
information, see “Configuring the Smart Plug-in for mySAP.com 
Monitors” on page 46.
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2 Tune the policies and monitors to suit the requirements of your 
environment before deploying them to the nodes you want to manage with 
the Smart Plug-in for mySAP.com. This will help prevent additional 
unwanted messages.

Creating policy groups

1 As OVO administrator, use the HP OpenView Operations Manager 
window illustrated in Figure 3 to make your own policy group from which 
you should remove those policies and monitors you do not need, as follows:

Figure 3 Removing Policies from Policy Group

a Expand the Policy Groups item and select and expand SPI for
mySAP.com to display all the default policy groups for the Smart Plug-
in for mySAP.com. 
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b Create a new policy group by selecting and right-clicking SPI for 
mySAP.com and selecting the following menu:

New > Policy Group

c Enter a name for the new policy group in the fields provided and click 
[OK].

d In the left pane, select the existing policy group from which you want 
to copy policies and, in the details pane, drag the policies you want to 
place in the new policy group over and drop them on to the policy 
group you have just created.

2 Deploy the new policy group to the SAP R/3 nodes by following the 
instructions below. Depending on which SAP R/3 version is installed on 
the managed nodes and whether the nodes are central instances or 
application servers. For example: SAP R/3 4.B Central Instance
SAPWolf2. 

a In the console tree, select and right click the new policy group or 
groups you have created (containing the monitors you need) and use 
the following menu option:

All Tasks > Deploy on...

Remember to use this opportunity to deploy any individual 
policies not present in the SAP R/3-specific policy groups.
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b Use the Deploy Policies on... window to select the managed 
nodes to which you want to deploy the new policy group as illustrated 
in Figure 4 below.

Figure 4 Deploying Smart Plug-in for mySAP.com Policies

3 Click [OK] to finish deploying policies.

4 You can check the successful deployment of policies by right clicking a 
managed node and selecting the following menu option from the drop-
down menu that is displayed:

Policy Inventory > Deployment jobs 

Some of the monitors may require SAP configuration. See 
“Configuration: OVO Administration Tasks”  beginning on page 43 for 
additional information on SAP-Specific tasks.
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Specifying SAP R/3 Systems to Monitor

This section describes how to use the configuration-file policy editor to 
define which SAP R/3 Systems the Smart Plug-in for mySAP.com should 
monitor. The SAP R/3 Systems monitored by the Smart Plug-in for 
mySAP.com are defined in the r3itosap.cfg configuration file. For 
more information about policy deployment, see “Deploying Smart Plug-in 
for mySAP.com Policies to SAP R/3 Managed Nodes” on page 48.

Informing the SPI for mySAP.com which SAP R/3 clients to monitor

1 In the OVO console tree, browse to the following directory: 

Policy management > Policy groups > SPI for mySAP.com

2 In the OVO Console, locate and double-click the global_r3itosap file. 
The configuration-file policy editor displays the selected file as illustrated 
in  Figure 5 on page 53.

3 Using the format of the examples in the r3itosap.cfg configuration file, 
add an entry for each SAP R/3 instance, which you want to monitor. 

You have to set up SAP R/3 users for each SAP R/3 client. The 
list of SAP R/3 clients you made in “Before You Begin” on page 
31 includes the information you need for each configuration 
line. For more information on how to set up SAP users for 
OVO, see “Setting Up an SAP User for OVO” on page 57.

When configuring a managed node equipped with two 
network cards, be sure to specify both hostnames in the 
r3itosap.cfg configuration file.
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4 Save your changes and exit the text editor. When saving the template, we 
recommend you use the configuration-file policy type naming conventions, 
for example: global_r3itosap

Figure 5 Editing the r3itosap.cfg File
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Configuration: SAP-Specific Tasks

This section describes how to complete the SAP-specific part of the 
installation of the Smart Plug-in for mySAP.com (SPI for mySAP.com).

Overview

The tasks in this phase require knowledge of SAP transactions and 
specific monitoring requirements. You will be working with the OpenView 
Operations (OVO) GUI as well as on the SAP system application servers. 
You will need to log in to OVO as an operator and to the SAP clients as a 
user with authority to perform the SAP tasks included in this phase. The 
tasks in this section may be summarized as follows:

1 “Setting Up the XMI Authorization Profile” on page 56.

2 “Setting Up an SAP User for OVO” on page 57.

This step is necessary so that an SAP R/3 log on can be made whenever 
OVO tools, monitors, or actions need to access SAP.

3 “The OVO Agent User Account on Windows NT” on page 60.

This step is only required for SAP version 3.1I or earlier. Later 
versions of SAP R/3 provide this authorization profile.
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Without access to the shared memory, service views will not work and the 
Smart Plug-in for mySAP.com monitors cannot determine if an SAP 
system is up or down.

4 “Applying the SAP Transport” on page 63.

In this step, you copy the Smart Plug-in for mySAP.com transport files to 
the SAP transport directories on each SAP R/3 central instance and apply 
them. These files are placed temporarily in the OVO directory to facilitate 
the OVO administrator task of distribution of Smart Plug-in for 
mySAP.com components to SAP nodes.

5 “Setting Up Configuration Values for the mySAP.com SPI Monitors” on 
page 66.

This topic is covered in much greater detail in the section on monitor 
customization.

6 “Creating Configuration File Policies” on page 68.

In this step, you use the configuration-file policy editor to create global 
configuration-file policies. This topic is covered in much greater detail in 
the section on monitor customization in the HP OpenView for Smart Plug-
in for mySAP.com Administrator’s Reference.

Setting Up the XMI Authorization Profile

If you are working with SAP R/3 version 3.1I and want to use the 
r3monxmi Syslog monitor, which uses the XMI API in SAP R/3, you need 
to set up an XMI authorization profile.

Setting up an XMI authorization profile

1 Log on to SAP R/3 3.1x.

2 Call transaction /nsu02.

After you have set up and deployed the configuration-file policies, the 
corresponding Smart Plug-in for mySAP.com policies must also be 
deployed to the SAP R/3 managed nodes. See “Deploying Smart Plug-
in for mySAP.com Policies to SAP R/3 Managed Nodes” on page 48.
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3 Create a new profile called: SAP_XMI_ALL.

The profile name defined here is not to be confused with the name of the 
authorization objects which you use to define the profile later.

4 In the Profile List window, double-click the profile: 

SAP_XMI_ALL

5 Click the [Insert authorization] button

6 Scroll down the list of object classes and double-click the following item.

Basis: Administration

7 In the Class Basis: Administration window, scroll down the 
authorization list and select the following authorizations to assign them to 
the SAP_XMI_ALL profile.

8 Click the check button to add the authorizations. The authorizations you 
have added appear in the Consisting of authorizations field.

9 Activate the new profile using the following menu sequence:

Profile: Activate...

Setting Up an SAP User for OVO 

For every client which allows automated log on of OVO operators:

1 Log on to SAP R/3

2 Call the transaction /nsu01

Authorization... Object...

S_XMI_ADMIN Auth. for external management...

S_XMI_ALL CCMS...
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3 Create a new user named ITOUSER. Specify the following parameters:

User type: DIALOG

If User type is not set to DIALOG and a 
corresponding password not configured, 
the SAP GUI will not work and many of 
the operator- initiated actions and tools 
within OVO will be unavailable.

Initial password: any SAP-admissible value except 
HPSAP_30

HPSAP_30 is the password you are 
expected to use when you next log in to 
SAP (as ITOUSER) and are prompted 
to change ITOUSER’s initial password.

Authorization profiles: S_A.ADMIN (SAP R/3 3.1x only)

S_XMI_ALL 

SAP_ALL_DISPLAY

For more information about 
SAP_XMI_ALL, see “Setting Up the XMI 
Authorization Profile” on page 56.

User roles: SAP_ALL_DISPLAY (4.6C only)

Display authorization for all modules 
except BC, CA, and HR. ITOUSER 
requires this authorization to be able to 
execute Smart Plug-in for mySAP.com 
ABAP functions.
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Figure 1 SAP R/3 4.6C User Roles for ITOUSER

4 Log on to SAP R/3 as user ITOUSER.

5 When prompted, change the initial password. Enter the following new 
password: 

HPSAP_30.
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The OVO Agent User Account on Windows NT

The user account HP ITO account on Windows NT managed nodes is 
used by the OVO agent and must be member of the group 
SAP_<SID>_LocalAdmin in order to access the SAP R/3 shared memory. 
Without access to the shared memory, service views will not work and the 
Smart Plug-in for mySAP.com monitors will not be able to determine if an 
SAP system is up or down. To check and, if necessary, change the 
configuration of the HP ITO account on a Windows NT system:

Configuring the HP ITO account on a Windows NT system

1 Start the User Manager by using the following menu sequence:

Start:Programs > Administrative Tools (Common) > User
Manager for Domains

2 Locate and double click the user name: HP ITO account. The User
Properties window appears.
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3 In the User Properties window, click the [Groups] button. The Group
Memberships window appears as illustrated in Figure 2.

Figure 2 The Group-Memberships Window

4 In the Group Memberships window, make sure that group 
SAP_<SID>_LocalAdmin appears in the Member of: list. If it does not, 
then locate the SAP_<SID>_LocalAdmin group in the Not Member of:
list and use the [<- Add] button to add it to the Member of: list. 

5 Click [OK] to save the changes. 
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Configuring the HP ITO account on a Windows 2000 system

1 Start the Computer Management by using the following menu sequence:

Start:Programs > Administrative Tools > Computer Management

2 Locate and double click the user name: HP ITO account. The Local
Users and Groups window appears.

3 In the right-hand pane of the Computer Management window, double
click the Users button. 

4 The HP ITO account properties window appears.

5 Click Member of tab.

6 Locate Users and click the Add button. The Select Group window 
appears.

7 Locate HP ITO account and click the Add button.

8 Click OK to save the changes. The new group appears in the lower left-
hand pane.
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Applying the SAP Transport 

In this step, you copy the transport files that are delivered with the Smart 
Plug-in for mySAP.com to the SAP transport directories on each OVO 
managed node that is an SAP R/3 central instance. 

SAP transport files directories can be copied to the OVO managed node(s) 
in the following two ways:

• via OVO managed nodes

• via the SAP R/3 GUI

The naming conventions used for the transport objects are as follows:

To copy the Smart Plug-in for mySAP.com transport files to the OpenView 
Operations managed nodes:

1 Use the Windows Explorer tool to locate the SAP R/3 transport packages, 
which by default reside in the following directory:

<system drive>:\Program
Files\HPOpenView\Packages\SAPTransports

The SAP transport package is stored in the SAP specific .car format and 
is accompanied by a readme file explaining which SAP transports must be 
imported into each SAP R/3 version.

Objects in Smart Plug-in for mySAP.com

Development Class:  ZSPI

Function Groups: ZLPO
ZSPB
ZSPA

Function modules: Y_HP_ITO_*

Programs: YSPI*
ZHPSPI*
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2 Use the ftp tool to transfer the package to each of the SAP R/3 central 
instances you want to manage with OpenView Operations.

3 On each of the managed nodes, as SAP administrator (<SID>adm) use the 
CAR (or SAPCAR) command to unpack the transport files to /usr/sap/
trans. Enter:

CAR -xvf R3Trans.car

4 Continue importing the SAP transport files either via command line or via 
SAP R/3 GUI following the instructions given below.

Importing the Transport files via command line

1 Import the Smart Plug-in for mySAP.com transport to your SAP R/3 cen-
tral instance. For example, enter the following commands as SAP adminis-
trator on the appropriate Windows NT managed node:

cd \usr\sap\trans\bin
tp addtobuffer <transport file name> <SID>
tp import <transport file name> <SID> client=<client_ number>

Where <SID> is the SAP system ID and <transport file name> is one 
of the values, depending on SAP system version, shown in the 
accompanying readme file on the OVO management server (location see 
above).

Input <tp parameter filename> as the exact name of the tp parameter 
file, located in directory /usr/sap/trans/bin. For example, if your SAP 
system is version 4.6, the transport file name is K900xxx.SP1 .

If for any reason an error occurs, you can clean the buffer using the 
following command:

tp cleanbuffer <SID>

2 Repeat this procedure on each SAP R/3 system you want to manage with 
OVO.

This following procedure requires the CAR/SAPCAR command, which you can find on 

any SAP Kernel CD. The SAPCAR command appears with mySAP.com 4.6or later.
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Importing the Transport files from the SAP R/3 GUI

1 Log into all SAP systems where you wish to apply transport file.

2 From the SAP R/3 GUI enter the following transaction ID:

/nstms as illustrated below:

3 From the SAP Transport Management System login, click the Transport 
icon (or F5) as illustrated below in red.

4 Select the correct SID (queue) where you wish to import the transport.

5 From the file menu select

Extras > Other requests > Add

6 From the Transport Request to import Queue type the following:

a Transport file name

This procedure is only valid for SAP R/3 versions 4.x and higher.

Transports must be applied to each SAP system.
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File names are located in the accompanying readme file on the OVO 
management server (location see above).

b Enter the target client (000 is the default client number).

c Select the check icon or use the Enter key to add transaction requests.

7 Highlight the desired transport.

8 Select Request > Import and the Import Request box appears 

9 Check items in the Option tab that are appropriate for your system.

10 Click the check icon or Enter key.

Setting Up Configuration Values for the 
mySAP.com SPI Monitors

To conclude the SAP-specific tasks, you have to set up initial configuration 
values for the Smart Plug-in for mySAP.com monitors before you deploy 
the configuration files to the managed nodes. The Smart Plug-in for 
mySAP.com includes the monitors listed in Table 1 below.

If a transport is not selected, all transports in the list will be 
selected.

Table 1 Smart Plug-in for mySAP.com Monitors

Monitor Name Description

r3monaco Alert collector for TemSe calls

r3monale ALE monitor

r3monal CCMS monitor

r3monchg System change monitor

r3moncts Correction and Transport system monitor

r3mondev Trace monitor of the SAP logfile:
<SID>/<INSTANCE>/work/dev*)
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The Smart Plug-in for mySAP.com also includes two sets of configuration 
and distribution tools as follows:

For information about and instructions for configuring monitors see the 
on-line HELP.

r3mondmp ABAP/4 Dump monitor

r3monjob Job monitor

r3monlck Lock check monitor

r3monoms Operation mode switch monitor

r3monpro Operating system process monitor

r3monsap Alert monitor

r3monspl Spool monitor

r3montra Transport monitor

r3monupd Update monitor

r3monusr User monitor

r3monwpa Work-process availability monitor

r3monxmi XMI syslog monitor

Table 1 Smart Plug-in for mySAP.com Monitors (Continued)

Monitor Name Description

Global tools which can be applied to all managed nodes

Local tools which apply only to a specified managed node
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Creating Configuration File Policies

In this step you use the configuration-file policy editor to create global 
configuration files (from the default files) for each of the SPI for SAP R/3 
monitors which run on the SAP R/3 servers. 

To create a new configuration-file policy for the SPI for SAP R/3 monitors

1 From the OVO console tree, browse to the following directory:

Policy Management > Policy Group > SPI for mySAP.com

2 In the details pane, select right click the policy group that matches the 
version of SAP R/3 which is installed in your environment and the type of 
instance: Central or Application Server. Then add a new configuration file 
by using the following menu sequence:

New > ConfigFile

3 Click the General tab and use the pull-down menus provided to enter the 
following values in the appropriate fields, as illustrated in  Figure 3 on 
page 69.

Application SAP_SPI

Sub-Group Global

Filename r3mondmp.cfg

The filename r3mondmp.cfg is used here only as an example. 
If you want to modify the default configuration files, edit the 
global configuration file which corresponds to each of the 
Smart Plug-in for mySAP.com monitors you want to deploy to 
(and run on) the SAP R/3 managed nodes.
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4 Select the Data tab and click [Load Template] button. The monitor 
name file you selected is displayed.

Figure 3 Configfile dialog box

5 Scroll down to the bottom of the configuration-file policy and make the 
appropriate modifications.

6 Save your configuration-file policy and exit the editor. When saving your 
policy, we recommend you use the configuration-file policy-type naming 
conventions, for example: global_r3mondmp.cfg. The newly created 
configuration policy for the SPI for SAP R/3 monitor appears in the list of 
policies in the details pane.

7 Deploy the newly created configuration-file policies to the SAP R/3 
managed nodes as described in “Deploying Smart Plug-in for mySAP.com 
Policies to SAP R/3 Managed Nodes” on page 48.
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SAP Internet Transaction Server (ITS) 
Monitoring

Installing the ITS Monitor

The instructions in this section assume that either OVO Embedded 
Performance Agent (Coda) or the HP OpenView MeasureWare agent is 
already installed on all OVO managed nodes, where the ITS Monitor is 
required.

To install the ITS Monitor on an OVO managed node, you need to perform 
the steps indicated below, each of which is described in more detail in the 
appropriate subsections that follow:

• “Pre-requisites” on page  72.

• “Deploying the ITS Monitor Instrumentation” on page  75.

• “Deploying the Config File Policy Types” on page  77.

• “Deploying ITS Policies on the ITS Node” on page  77

• “Verifying Deployment of the Config File Policy Types” on page  78.

An ITS Monitor only needs to run on hosts where the SAP ITS AGate 
component is installed.
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Pre-requisites

Before you start the installation of the ITS Monitor, make sure that the 
ITS AGate node on which you have chosen to install the ITS Monitor 
meets the following requirements:

• Operating system: Windows NT 4.0, Windows 2000

• OVO agent installed and running

• Config File Policy Package for Windows Node is deployed

• either the MeasureWare agent for Windows NT/Windows 2000 or the OVO 
Embedded Performance Agent

• SAP R/3 version: 4.x - 4.6D Compilation 4

Not on the AGate system, but somewhere in your environment, you need:

• HP OpenView PerfView or HP OpenView Performance Manager

— for viewing the collected metrics

• HP OpenView Reporter

— for viewing long-term analysis data

The successful installation of the ITS Monitor depends on the presence 
of the SPI data collector instrumentation wrapper utilities 
on the OVO management server.
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Setting up the ITS Monitor for Performance 
Monitoring Tasks

The ITS Monitor uses information in the ITS global.srvc configuration 
file to provide a default configuration automatically. However, to set up 
the ITS Monitor to collect performance information, you need to perform 
the following configuration tasks:

1 Make sure that the ITS Monitor has access to (and the necessary permis-
sions for) the directories containing the following log files:

<root>\Program Files\SAP\ITS\2.0\<ITS_Instance_Name>\logs

2 Activate performance monitoring by setting the following keys to the 
value one (1) in the Registry on the managed node for each ITS instance:

a Enable the command interface under:

HKEY_LOCAL_MACHINE\Software\SAP\ITS\2.0\<ITS_instance>\
\Programs\AGate\AdminEnabled

b Configure performance monitoring under:

HKEY_LOCAL_MACHINE\Software\SAP\ITS\2.0\<ITS_instance>
\CCMS\PerfMonitoring

c Restart the AGate instance(s) to activate the changes made to the 
registry.
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Example 1 Setting Registry Keys with the ITS Administrator GUI

Example 1 displays set the appropriate SAP ITS registry keys 
using the ITS administrator GUI. Enter:
http://<hostname>:<port number>\scripts\wgate\admin!
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Deploying the ITS Monitor Instrumentation

1 In the OVO console window, select and right-click the mySAP.com (man-
aged node) where the ITS components will be deployed.

2 Browse to the following menu option:

All Tasks > Deploy instrumentation

3 From the Deploy Instrumentation window select the following as 
illustrated in  Figure 1 on page 76:

• Action

• Command

• Monitor

• SPI Data Collector

4 Select OK as illustrated in  Figure 1 on page 76.

You can monitor the deployment as it occurs in the Deployment Jobs 
window.

5 Click OK.
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Figure 1 Deploying Instrumentation Files
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Deploying the Config File Policy Types

1 From the OVO console, browse to the following:

Policy management > Policy groups > SPI for my SAP.com

2 Select all policies beginning with global_r3

Deploying ITS Policies on the ITS Node

1 From the OVO console browse to the following:

Policy management > Policy groups > SPI for mySAP.com > 
mySAP.com ITS

2 Select and right-click the following files:

• r3itsperfmon (Scheduled Task)

• SAP R3 opc msg (Open Message Interface)

3 Browse to the following:

All Tasks > Deploy on

4 Select the ITS node where the policies will be deployed.

5 Click OK.

The r3itsperfmon.cfg configuration file policy must be 
select when deploying Configuration file policy types
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Verifying Deployment of the Config File Policy Types

1 Select and right-click the ITS node and browse to the following:

View > Policy Inventory

2 In the right-hand pane of the OVO console the following files should appear 
as displayed in Example 2 below:

Example 2 ITS Policy Inventory Verification Files

For more information about what information is copied where during the 
installation of the ITS Monitor, see hp OpenView SPI for mySAP.com 
Administrator’s Reference Online Help.

Removing the ITS Monitor

This section describes how to remove the ITS Monitor from the managed 
node quickly and easily. To remove the ITS Monitor software from the 
OVO managed node, you should carry out the following steps in the order 
specified.

1 Right click the ITS node and browse to the following:

View > Policy inventory

2 In the policy inventory list select the policies listed above, and from the 
drop down menu select the following as illustrated in Figure 2:

Name Type

r3itsperfmon Scheduled Task

SAP R3 opc msg Open Message Interface

global_r3itsperfconfig Config File
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All tasks > Remove from node

Figure 2 Removing the ITS Monitor
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Smart Plug-in for my SAP.com 
Performance Monitors

This section describes how to install and configure the SPI for mySAP.com 
performance package. It also provides information about how to put the 
performance monitors to best use and supplement the information 
provided by the SPI for mySAP.com performance monitors with 
information supplied by the MeasureWare agent. The section includes the 
following topics: 

• “Performance Monitors Overview” on page 82 

• “De-/Installing the Performance Monitor” on page 83 

• “Locating the Performance Monitor Files” on page 88 

• “Configuring the Performance Monitor” on page 90 

• “Managing the Performance Agent” on page 94 
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Performance Monitors Overview

The SPI for mySAP.com Performance Monitors collect SAP R/3 
performance data. This data can then be used to compare trends between 
SAP R/3 business transactions and other system metrics. The 
Performance Monitors can then be used to monitor, manage, and correlate 
this data centrally along with any other application, database, system and 
network data. 

Figure 1 Performance Data displayed through Perfview

Implemented ABAP-function modules inside SAP R/3 are accessed via an 
RFC-call. The Performance Monitors gather a snapshot of SAP runtime 
performance data. 
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In addition to the R/3 Performance Alert Monitor (rz03), which is part of 
the SAP R/3 CCMS subsystem, the SPI for mySAP.com Performance 
Agent is able to collect over 100 additional metrics. 

The new SPI for mySAP.com performance agent can be configured to 
specify which performance monitors should be run on which SAP R/3 
instances and how frequently. MeasureWare Agent or OVO Embedded 
Performance Agent (CODA) alerts the management station when defined 
thresholds are exceeded. 

The MeasureWare Agent runs under Windows as a service and under 
Unix as a daemon (background) process that runs independently of the 
OVO agent processes. In order to start/stop the SPI for mySAP.com 
performance monitor processes, use the appropriate OVO tools in the OVO 
Tools window. 

De-/Installing the Performance Monitor

This section describes how to: 

•  “Selecting the Performance Data Source” on page 84.

•  “Changing Default Settings for the Performance Data Source” on page 85

• “Deploying Performance Monitor Package” on page 86

• “De-Installing Performance Packages” on page 87

Note that the instructions in this section assume that:

– either the MeasureWare agent or the OVO Embedded Performance 
Agent is installed

– SAP R/3 version 3.1I, 4.0B, 4.5B, 4.6C, or 4.6D is installed 

– the OVO Enterprise Message/Action Agent is already installed and 
running on the SAP R/3 servers, which you want to manage with 
OVO.
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Selecting the Performance Data Source

By default, OVO deploys the OVO Embedded Performance Agent (Coda) 
with all OVO A.07.00 agents. All OVO A.07.00 Smart Plug-ins use the 
OVO Embedded Performance Agent as the default source for the 
performance data required for graphing in OpenView PerfView and 
OpenView Reporter. However, previously installed OpenView products 
that use the MeasureWare Agent will continue to use MeasureWare as the 
data source.

However, if you prefer to use MeasureWare as the agent for newly 
installed OpenView products rather than the OVO Embedded 
Performance Agent (for example, to be able to use PerfView, which does 
not support the OVO Embedded Performance Agent), you can override the 
default use of the OVO Embedded Performance Agent by setting up a 
small text file, nocoda.opt, which changes the default data source from 
Coda to MeasureWare.

Once configured, the nocoda.opt file must be stored in a specific location 
on each managed node, whose performance-data source you want to 
change. The location of the nocoda.opt file on the managed node varies 
according to the operating system running on the OVO management 
server and managed node. Table displays the location of the nocoda.opt 
files on nodes managed by an OVO for Windows management server. 

Table 1 OVO 7.0 for Windows Management Servers

Managed Node Operating System Location of the nocoda.opt file

AIX /var/lpp/OV/conf/dsi2ddf/nocoda.opt

HP-UX/Solaris /var/opt/OV/conf/dsi2ddf/nocoda.opt

Windows \Program Files\HP OpenView\
{790C06B4-844E-11D2-972B-
080009EF8C2A}\ 
conf\dsi2ddf\nocoda.opt
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Changing Default Settings for the Performance Data Source

To change the default setting for the data source follow the instructions 
below: Open the nocoda.opt file in a text editor and manually enter the 
appropriate information using the format and syntax illustrated in 
Example: The nocoda.opt File. 

1 To designate MeasureWare as the agent for all data sources, enter the key 
word ALL at the top of the file. 

2 To designate MeasureWare as the agent for a data source tied to a specific 
SAP R/3 (or SAP R/3 ITS) instance, include a reference to each instance on 
a separate line of the nocoda.opt file, using the following format as 
illustrated in Example 1 on page 85:

For... Use the following format...

SAP R/3: R3_<SAP_Hostname>_<SAPSID>_<SAP_Instance_ 
Number>_DATA 

SAP R/3 ITS: R3ITS_<Virtual_SAPITS_Instance_Name>
_<SAPITS_Hostname>_DATA 

3 Save the changes to the nocoda.opt file.

4 Restart the OVO agent on the managed node where the nocoda.opt file 
has been modified.

Example 1 The nocoda.opt File

###########################################
# Add to (or modify) the contents of this file to change the 
# data-source from the default Coda to MeasureWare
###########################################
# All hosts: 
ALL 
# SAP R/3 hosts/instances: 
R3_ovsdsap_DEV_00_DATA 
# SAP R/3 ITS hosts/instances: 
R3ITS_SP6_00_ovspi_DATA 
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Deploying Performance Monitor Package

Follow the instructions below to deploy the Performance Monitor 
instrumentation from the OVO Management Server to the OVO managed 
node systems. 

1 From the OVO console window, select and right-click the mySAP.com 
node.

2 Browse to the following menu option:

All tasks > Deploy instrumentation 

3 Select the following files as illustrated in Figure 2:

• SPI Data Collector

• SPI for mySAP.com Performance Package

Figure 2 Deployment Package Selection

4 Select OK. 
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De-Installing Performance Packages

Follow the instructions below to install the Performance Packages after 
having deployed them in the previous step. 

1 From the OVO console window, select the following:

Tools > SPI for mySAP.com > SAP R/3 Admin

2 Select the tool corresponding to your Operating System (Unix or 
Windows).

3 Select the mySAP.com managed node(s) where you want to start the 
Performance Package installation, as illustrated in Figure 3 below. Please 
be careful only to select nodes which correspond to the OS of the selected 
tool (UNIX or Windows).

4 Click Launch to start the installation.

Figure 3 Performance Package Deinstallation
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5 For deinstallation just select the corresponding deinstallation tool and 
follow steps 1-4 above. After deinstallation you should also undeploy the 
SPI for mySAP.com performance monitor package.

Locating the Performance Monitor Files

This section lists the files installed as part of the SPI for mySAP.com 
performance package for the following platforms: 

•  “AIX” on page 88.

•  “HP-UX/Solaris” on page 89.

•  “Windows” on page 89.

AIX

This section lists the files installed as part of the SPI for mySAP.com 
performance package for AIX: 

• Binaries: /var/lpp/OV/bin/R3PerfAgent/bin 

— r3perfconfig: Performance Monitor configuration tool. 

— r3perfagent: Performance Monitor Agent. 

— compdsifile.sh: Shell script used by the r3perfconfig tool to compile the 
dsilog files. Not to be executed independently. 

• Configuration files: /var/lpp/OV/conf/SAP_SPI/[local | global] 

— r3perfagent.cfg: Global and local configuration file for the various 
performance monitors. 

• Dsilogfiles: /var/lpp/OV/bin/R3PerfAgent/data 

— R3_<HOSTNAME>_<SID>_...: On installation, this directory is empty. 
It is used to store the dsilogfiles compiled by r3perfconfig and 
compdsifile.sh files. 

• Templates: /var/lpp/OV/bin/R3PerfAgent/template 

— R3statistics.<PERF-MONITOR>: files used to compile the dsilogfiles. 

— Parm.UX: Parameter file template. 
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HP-UX/Solaris

This section lists the files installed as part of the SPI for mySAP.com 
performance package for HP-UX and Solaris: 

• Binaries: /var/opt/OV/bin/R3PerfAgent/bin 

— r3perfconfig: Performance Monitor configuration tool. 

— r3perfagent: Performance Monitor Agent. 

— compdsifile.sh: Shell script used by the r3perfconfig tool to compile the 
dsilog files. Not to be executed independently. 

• Configuration files: /var/opt/OV/conf/SAP_SPI/[local | global] 

— r3perfagent.cfg: Global and local configuration file for the various 
performance monitors. 

• Dsilogfiles: /var/opt/OV/bin/R3PerfAgent/data 

— R3_<HOSTNAME>_<SID>_...: On installation, this directory is empty. 
It is used to store the dsilogfiles compiled by r3perfconfig and 
compdsifile.sh

• Templates: /var/opt/OV/bin/R3PerfAgent/template 

— R3statistics.<PERF-MONITOR>: files used to compile the dsilogfiles. 

— Parm.UX: Parameter file template. 

Windows

This section lists the files installed as part of the SPI for mySAP.com 
performance package for Windows: 

• Binaries: %OVAgentDir%\bin\SAP_SPI\R3PerfAgent\bin

— r3perfconfig: Performance Monitor configuration tool. 

— r3perfagent: Performance Monitor Agent. 

— r3perfagent_service: Starts the Performance Monitor Agent as an 
service under Windows. 

— Compdsifile.bat: Batch program used by the r3perfconfig tool to compile 
the dsilog files. Not to be executed independently. 
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• Configuration files: 
%OVAgentDir%\bin\SAP_SPI\R3PerfAgent\bin\global

— r3perfagent.cfg: Configuration file for the various performance 
monitors. Note that this directory is created after the first SPI for 
mySAP.com performance package policies have been deployed 

• Dsilogfiles: %OVAgentDir%\bin\SAP_SPI\R3PerfAgent\bin\data

— R3_<HOSTNAME>_<SID>_...: On installation, this directory is empty. 
It is used to store the dsilog files compiled by: r3perfconfig.bat and 
compdsifile.bat 

• Templates: %OVAgentDir%\bin\SAP_SPI\R3PerfAgent\bin\template

— R3statistics.<PERF-MONITOR>: files to used to compile the dsilog 
files. 

— Parm.NT: Parameter file template. 

Configuring the Performance Monitor

Before starting to configure the Performance Monitor note that if 
MeasureWare Agent is used instead of OVO Embedded Performance 
Agent (Coda), then stop MeasureWare Agent on the managed node using 
the following commands appropriate to your system environment: 

After having stopped the MeasureWare agent you can now start to 
configure the performance monitor. In case you are using the OVO 
Embedded Performance Agent (Coda), you do not have to take any action 
before configuring the performance monitor.

Configure the Performance Monitor

1 On the node where the Performance Monitor Agent is installed, switch to 

Table 2 Stopping MeasureWare Agent commands

AIX /usr/lpp/perf/bin/mwa stop

HP-UX/Solaris /opt/perf/bin/mwa stop 

Windows mwacmd stop
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the appropriate directory and enter the following command to run configu-
ration scripts: 

Windows: r3perfconfig

UN*X: ./r3perfconfig

Follow the instructions which appear on screen. The script lists the SIDs it 
finds together with a number, and prompts you to select the SAP R/3 
instance to be configured. See Example 1 on page 91.

Example 1 Installed SAP Instances

-------SID SapNr HostName --------------
(0) AST 0 sapper
(1) DEV 1 ovsdsap1

Choose:
(x) to configure shown system
888 to manually configure a SAP system
999 to quit

Enter the appropriate identification number, for example; 0 for AST. If you 
choose 888 to configure an SAP R/3 SID from scratch, you are required to 
answer a series of questions concerning the SAP SID you want to 
configure. 

When you are finished, the dsilog files are then compiled and the data 
source is added to the MeasureWare-agent configuration file: 

Windows: perflbd.rc

UN*X: perflbd.mwc

On completion, the r3perfconfig script prompts you to restart the 
MeasureWare agent. However, it makes sense to update the parm.mwc 
file as described in step below before you start the MeasureWare agent. 

2 In the next step, on the OV Management Server, you configure the SPI for 
mySAP.com performance monitors in the r3perfagent.cfg file. If you do not 
complete this task, all monitors will run with the default settings as 
illustrated in  Figure 4 on page 92. 
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Figure 4 The Default Global r3perfagent.cfg File

There are two possible configurations: 

• Global - global_r3perfagent.cfg
SPI for mySAP.com performance monitor settings for all SAP R/3 servers 

• Local - local_r3perfagent.cfg

local SPI for mySAP.com performance monitor settings for individual SAP 
R/3 servers

The settings in the global configuration files are used for all 
nodes which do not have local configuration settings. Where 
both files are present, local settings override global ones.
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You should use the configuration-file policy editor to create or modify the 
r3perfagent.cfg file: 

3 To modify an existing configuration file

a Select the policy view and, in the details pane, select and right-click 
the appropriate r3perfagent.cfg file, and click the following menu 
option: 

All Tasks > Edit...

b The r3perfagent.cfg file is displayed as illustrated in  Figure 4 on 
page 92.

4 To create a new configuration-file 

a In the OVO console tree, expand the Policy Management policy group, 
select and right-click the SPI for mySAP.com policy group, and add a 
new configuration file by selecting the following option from the pop-
up menu that appears:

New > ConfigFile

b Load the default global_r3perfagent.cfg file, change any values as 
required, and save the file. If you want to create a local configuration 
file, we recommend you include the name of the machine for which the 
local configuration is intended in the local-configuration file name as 
outlined below: 

<machine_name>_r3perfagent.cfg. 

You have to deploy the modified policy to the managed node 
(<machine_name>) and restart both the MeasureWare agent and the 
SPI for mySAP.com performance monitor in order to upload and apply 
the modified configuration. 

5 Deploy the modified policies 

By default: 

— all SPI for mySAP.com performance monitors are enabled for all 
SAP hostnames, systems, numbers and clients. 

— the polling intervals are set for each monitor in minutes. 

— Hold Connections is disabled. 
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6 Start (or stop and restart) the MeasureWare agent on the managed node 
by entering the following command in a shell or by using the menu options 
in the appropriate tool/application group. 

UN*X: mwa [stop | start]

Windows: mwacmd [stop | start]

7 On the managed node, switch to the directory in which the r3perfagent 
command resides (see “Locating the Performance Monitor Files” on page 
88) and start (or stop and restart) the performance monitor by entering 
the following command in a shell:

Windows: r3perfagent_service [-e | -s]

UN*X: ./r3perfagent [stop | start]

Managing the Performance Agent

The SPI for mySAP.com performance monitor can be controlled either by 
using command-line options which differ according to the platform and 
operating system, or the tools that are installed by the SPI for 
mySAP.com:

•  “Command-Line Options” on page 94.

•  “SPI for mySAP.com Tools” on page 95.

Command-Line Options

On UN*X, you can use the r3perfagent command to manage the SPI for 
mySAP.com performance monitor. The UN*X r3perfagent command 
accepts the following command-line options: 

r3perfagent [start | status | stop]

• r3perfagent start - to start the SPI for mySAP.com performance monitor. 

• r3perfagent stop - to determine the current status of the SPI for 
mySAP.com performance monitor. 

• r3perfagent status - to stop the SPI for mySAP.com performance monitor. 
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On Windows, you can use the r3perfagent_service command to manage 
the SPI for mySAP.com performance monitor. The r3perfagent_service 
command accepts the following command-line options: 

r3perfagent_service -e -i -s -u

• -i registers the service 

• -u de-registers the service 

• -s starts the service 

• -e stops the service 

SPI for mySAP.com Tools

Table 5 displays the tools that are available for the SPI for mySAP.com 
performance monitor in the appropriate SPI for mySAP.com tool group-
SAP R/3 NT or SAP R/3 UN*X. 

Note that on Windows the r3perfagent services can also be 
controlled from the Services window, which you can start from 
the Windows Control Panel.

Table 5 Performance Monitor Tools

Application Name SAP R/3 NT SAP R/3 UN*X

PerfAgt Start X X

PerfAgt Stop X X

PerfAgt Status X
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7

Service Reports

In this Section

This section introduces the concept of Service Reports and explains how to 
use them in conjunction with the SPI for mySAP.com and OVO. The 
information in this section is designed specifically to help manage the SAP 
R/3 environment in an efficient and convenient manner. Detailed 
information about specific tasks are listed below:

• “What Are Service Reports?” on page  98

• “Upgrading the SPI for mySAP.com Reports” on page  99.

• “Installing the SPI for mySAP.com Reports” on page  100.

• “Deinstalling SPI for mySAP.com Reports” on page  107.
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What Are Service Reports?

Service reports are web-based reports that are produced by HP OpenView 
Reporter (OV Reporter) using Crystal Reports templates and viewed using 
a web browsers. OV Reporter allows you to request both scheduled and on-
demand versions of reports. 

Figure 1 Service Reports available with SPI for mySAP.com
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SPI for mySAP.com service reports correlate the data extracted from 
either the OVO Embedded Performance Agent (Coda) or the OpenView 
Performance agent (formerly MeasureWare). You can use the correlated 
data to generate reports which display short-, medium-, or long-term 
views of your IT environment and supplement the detailed, real-time 
graphs available with PerfView. The combination of reports and graphs is 
a powerful tool for trend analysis. For example, you can:

• identify potential bottlenecks in your IT system, so that you can take 
action before problems become acute.

• use the information to help you to make accurate predictions for future 
upgrades.

• collect accurate information to be used in measuring service levels.

Upgrading the SPI for mySAP.com Reports

Versions A.07.x and B.08.00 (SPI for mySAP.com Windows) of the SPI for 
mySAP.com have different versions of the SAP/Performance monitor which 
require different and incompatible versions of the OV Reporter. This means 
that old reports prepared with previous versions of the SPI for mySAP.com 
cannot be viewed with the current SPI for mySAP.com reporter integration. In 
addition, the old performance data gathered by the SAP/Performance 
subagent version A.07.x must be removed from the OV Reporter database 
before you install the reporter integration package supplied with the version 
B.08.00 of the SPI for mySAP.com.

1 Remove from the OV Reporter database all data collected by the old SAP/

Upgrading the SPI for mySAP.com reports in the manner described in 
this section removes from the OV Reporter system all old report data 
collected by the Smart Plug-in for mySAP.com. However, you can use 
database tools to preserve the tables containing information that you 
want to use after completing the upgrade process. For more 
information, see the documentation provided with the database 
product.
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Performance agent. You can use the following tool: 

C:\<OV Reporter>\newconfig\repsapclean.exe

2 Verify that the SPI for mySAP.com report groups and metrics lists are no 
longer present in the OV Reporter GUI.

3 Remove the old SPI for mySAP.com reporter-integration package using 
the standard Windows method:

Start: Settings > Control Panel > Add/Remove Software

4 Install the new SPI for mySAP.com reporter integration as described in 
“Installing the SPI for mySAP.com Reports” on page  100.

Installing the SPI for mySAP.com Reports

This section explains how to install the SAP R/3 and the SAP ITS service 
reports which come with the SPI for mySAP.com and, in addition, provides 
information designed to help you prepare for the installation.

Before You Begin

Before you install and set-up for the Service Reports, you must ensure 
that the following tasks have been completed:

1 Either the OVO Embedded Performance Agent or the OpenView Perfor-
mance agent must be installed on all SAP managed nodes for which you 
want to produce service reports.

2 OV Reporter must be installed on a Windows NT/2000 host.

3 The SPI for mySAP.com performance agent or the ITS Monitor must be 
configured.

4 To generate Service Reports for the SPI for mySAP.com, Seagate’s Crystal 
Reports version 8 (or later) needs to be installed and running on the 
machine hosting the OV Reporter (OV Reporter version A.03.00).
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Installing SAP R/3 Service Reports

The SAP R/3 and SAP ITS service reports are installed into the OV Reporter 
product as a snap-in package using InstallShield. During set-up you will be 
asked to select the common application path of OV Reporter. This is the folder 
where OV Reporter is installed. The set-up routine will attempt to discover 
this path automatically and in most circumstances you should avoid changing 
it.

The set-up copies components to the directories as summarized in Table 1 
on page  101. All directory paths are relative to the OV Reporter common 
application path.

There are two methods of installing OV Reporter, one of which you have 
to follow:

• on the OVO Management Server

• on a separate OV Reporter node

Installing OVO Reporter on the OVO Management Server 

Table 1 Locations of SAP Service Report Components

Component Directory

Installation script
\newconfig\

Configuration files

Report template files for SAP \data\reports\SAP

Report template files for SAP ITS \data\reports\SAPITS

This procedure only works if you have not previously installed OV Reporter 
(version A.03.00) and SPI for mySAP.com (version B.08.00). Follow  
“Installing OVO Reporter on a separate OV Reporter Node” on page 103 if 
this applies.
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If you have installed the OVO Reporter on the same machine as the OVO 
Management Server, execute the following steps to install the SPI for 
mySAP.com reports into the Reporter database. In case you have installed 
OVO Reporter on a separate machine, jump to the next set of instructions 
below.

1 From the Windows Start menu browse to the following:

Settings > Control Panel > Add/Remove Programs

2 Select HP OpenView Operations Performance for Windows

3 Select Change

4 Select Install products.

5 When the InstallShield Wizard dialog box displays, select the 
following:

• mySAP.com

• hp OpenView Reporter

by placing a check mark in the box as illustrated in Figure 2 on page 103.
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6 Follow the on screen Install Wizard instructions to complete the 
installation until finished.

Figure 2 OpenView Reports Installation

Installing OVO Reporter on a separate OV Reporter Node

1 Insert Disk 2 of the OVO Windows CD set into the CD-ROM drive.

2 Browse to the following folder:

Disk2\SAP SPI Reporter Package

3 Select and execute the following file:
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sapspi_reporter.msi

4 Follow the on screen Install Wizard instructions to complete the 
installation as illustrated in Figure 3 on page 104.

Figure 3 OV Reporter InstallShield Wizard

Assigning Report Packages

The Report Packages set-up automatically assigns the following files:

• two new report groups: SAP_R3 and SAP_ITS

If you change the common application path, set-up will not be able to 
find its executables and will generate warning messages
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• new metric lists to the new SAP_R3 and SAP_ITS groups

• new group reports to the SAP_R3 and SAP_ITS groups

• new system reports to the SAP_R3 and SAP_ITS groups

Configuring Report Packages

1 Verify that the installation of the SPI for mySAP.com service reports com-
pleted successfully by confirming that setup created the report and met-
rics groups mentioned in the previous step.

2 From the OV Reporter console browse to the following as illustrated in  
Figure 4 on page 105:

File > Configure > Report Packages

• SPI for ITS_mySAP.com

• SPI for mySAP.com

Both packages should be in the list of Installed Packages.

Figure 4 Configuring Report Packages
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3 Add your SAP R/3 and SAP ITS systems to the appropriate OV Reporter 
group. Note that you can use the following values in the Add System 
window:

System host.name.com

Network  SAP

Domain  either SAP or ITS as appropriate

4 Click OK and the systems appear in the OV Reporter’s Details Pane.

5 Use the OV Reporter GUI to schedule the generation of the SPI for 
mySAP.com reports or generate them now using the following option as 
illustrated in  Figure 5 on page 106:

Actions > Run > Generate Reports

Figure 5 SPI for mySAP.com Reports and Metrics
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Deinstalling SPI for mySAP.com Reports

In order to completely remove the SPI for mySAP.com Reports the 
following steps must be completed:

• “Deinstalling the Report Snap-in Packages” on page 107.

• “Removing Binaries from the OV Reporter system” on page 108.

Deinstalling the Report Snap-in Packages

1 From OV Reporter browse to:

File > Configure > Reporter Packages

2 Select the following files from the Installed Packages window located in 
the right pane of the Configure Report Packages window as illustrated in 
Figure 6:

• SPI for ITS_mySAP.com

• SPI for mySAP.com

3 Double-click the left arrow button to the Available Packages window 
located in the left pane of the Configure Report Packages window as 
illustrated in Figure 6.

Figure 6 Deinstalling Report Packages
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4 Click OK when you have finished.

Removing Binaries from the OV Reporter system

1 From the Windows Start menu browse to the following:

Settings > Control Panel > Add/Remove Programs

2 Select HP OpenView Operations Performance for Windows

3 Highlight Reports for hp OpenView smart plug-in for mySAP.com

4 Select Remove.

5 Follow the on screen instructions to complete the deinstallation process.
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Using the Smart Plug-in for 
mySAP.com

This section describes the Smart Plug-in for mySAP.com components that 
are integrated into OVO and explains how to use them.

Overview

After you have installed and configured the Smart Plug-in for mySAP.com 
you can begin to use it to monitor your SAP R/3 environment. When you 
log on to OVO using the user name and password of an operator with SAP 
responsibilities, you will see additional SAP-specific components in the 
OVO Manager window. Once you have deployed the Smart Plug-in for 
mySAP.com policies and instrumentation, you will also see SAP R/3 
related messages in the OVO message browser. 

This chapter provides an overview of the Smart Plug-in for mySAP.com 
components that are integrated into OVO and describes the steps and 
procedures to run a typical Smart Plug-in for mySAP.com session, 
including:

• “SAP R/3 Administration Tools” on page 110

• “Smart Plug-in for mySAP.com Tools for UN*X and NT Managed Nodes” on 
page 111
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• “Using the Smart Plug-in for mySAP.com Tools” on page 113

• “Accessing Data on SAP R/3 Managed Nodes” on page 116

• “Working with SAP R/3 Messages” on page 119

SAP R/3 Administration Tools

The SAP R/3 Admin group includes tools for editing and distributing files 
for global configuration, as well as other administrative functions such as 
writing SAP R/3 thresholds and activating alerts. The following table lists 
the tools which appear in the SAP R/3 Admin tool group and describes 
briefly what each of the tools does.

For more information about editing and distributing monitor 
configurations, see the Smart Plug-in for mySAP.com on-line HELP.

Table 1 SAP R/3 Admin Tools

Tool Description

Write SAP Threshold Apply the CCMS alert thresholds to an SAP 
R/3 system (old CCMS architecture only).

Write STAT Rec
Config

Write statistical records in SAP R/3

Deploy...

Install...

Remove...

Tools for deploying, installing and 
uninstalling the SPI for mySAP.com 
performance monitor packages
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Smart Plug-in for mySAP.com Tools for UN*X 
and NT Managed Nodes

The tools included in the SAP R/3 UN*X and SAP R/3 NT tools groups 
provide direct, context-sensitive access to SAP R/3 via the SAP R/3 front-
end. For example, if you have a performance alert, you can click the 
Performance icon and open the SAP performance analysis window. 

Some of the tools installed by the Smart Plug-in for mySAP.com appearing 
in the SAP R/3 UNIX and the SAP R/3 NT tool groups provide direct access 
to SAP R/3 via the SAP R/3 GUI. The following table lists the tools that 
are available, indicates in which group (UN*X or Windows NT) they may 
be found, and, in addition, shows which SAP R/3 transaction (Tcode) is 
called when the SAP R/3 GUI session starts.

You have to select the SAP R/3 managed node(s) on which you want the 
tool to run. Be sure to select the tool from the tool group that 
corresponds to the managed node’s platform.

Table 2 The SAP R/3 UN*X and NT Tools

Tool Name UX NT Description SAP 
Tcode

Check R/3
Database

• Attempts to connect to the R/3 
database to check availability

n/a

Control Panel • • Starts the SAP R/3 GUI and 
displays the CCMS control 
panel

RZ03

DB
Performance

• • Shows database performance 
through tables and indexes

DB02

Gateway • • SAP R/3 gateway monitor SMGW

Job Maintain • • Defines background jobs SM36

Job Overview • • Status of background jobs SMX
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Job
Performance

• • Displays Job performance by 
Job/User name, time, or status

SM39

Maintain
Thresholds

• • Maintenance of alert 
thresholds

RZ06

Operation
Modes

• • CCMS: Maintain operation 
modes

RZ04

Operation
Sets

• • Displays/Maintains operation-
mode sets

SM63

PerfAgt START • • Starts the Performance agent n/a

PerfAgt
STATUS

• Displays the status of the 
Performance agent

n/a

PerfAgt STOP • • Stop the Performance agent n/a

Performance • • Workload analysis ST03

Process • • Process overview SM50

Profile
Maintain

• • Profile maintain RZ10

R/3 Info • • Displays the installed R/3 
version, instance, hostname, 
etc.

n/a

Servers • • R/3 Server overview n/a

Start R/3
Frontend

• • Starts the SAP R/3 GUI n/a

Status R/3
Config

• Displays details of the status of 
any installed SAP R/3 
instances

n/a

Syslog • • Analysis of local System log SM21

Table 2 The SAP R/3 UN*X and NT Tools (Continued)

Tool Name UX NT Description SAP 
Tcode
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Using the Smart Plug-in for mySAP.com Tools

Expanding the Tools > SAP SPI Tools icon in the OVO console tree 
displays in the details pane the groups of tools provided by the Smart 
Plug-in for mySAP.com. The following tool groups are added to the 
OpenView Operations GUI when the Smart Plug-in for mySAP.com is 
installed:

• SAP R/3 Admin

• SAP R/3 NT

• SAP R/3 UN*X

Syslog Msg • • System log message 
maintenance

SE92

Users • • Displays general information 
about logged-on SAP R/3 users

AL08

Table 2 The SAP R/3 UN*X and NT Tools (Continued)

Tool Name UX NT Description SAP 
Tcode

Some of the tools make use of the SAP R/3 GUI. Make sure that the 
SAP R/3 GUI is already installed on the OVO management server or 
on the machine where a OVO administrator/operator console session is 
to be run.
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Figure 1 Selecting the Managed Node

To launch a Smart Plug-in for mySAP.com tool 

1 Expand the tool group which contains the tool you want to launch

2 Right click the tool you want to launch and select the following option 
from the menu which pops up:

All Tasks > Launch Tool...

3 In the window which appears, select the SAP R/3 nodes on which you want 
to run the Smart Plug-in for mySAP.com tool and click the [Launch...] 
button.
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R/3 Info is one of a number of tools which display information in the 
Tool Output field of the Tool Status window illustrated in Figure 3. 
However, the majority of Smart Plug-in for mySAP.com tools provide 
context-sensitive access to SAP R/3 by starting the SAP R/3 GUI and 
calling the appropriate Transaction. Figure 2 shows the window that 
appears when you launch the Syslog tool, which you can find in the SAP R/

3 UN*X and SAP R/3 NT tool groups.

Figure 2 Context-Sensitive Access to SAP R/3
115



Chapter 8: Using the Smart Plug-in for mySAP.com
Accessing Data on SAP R/3 Managed Nodes

The following Smart Plug-in for mySAP.com tools provide quick access to 
SAP R/3-related information from the selected managed node. The R/3
Info and Start R/3 Front-end tools are available on both UNIX and 
NT platforms; some other tools are available on UNIX platforms only. 

Each of the tools in the following list is explained in greater detail in the 
sections which follow. Where appropriate, real-life examples are used to 
demonstrate the more important aspects.

Check R/3 Database Establishes a connection to the 
database server and provides a quick 
way of checking the database 
connection. If multiple instances are 
installed, the tool prompts you to 
enter the System ID in which the 
database you want to check resides

R/3 Info Returns the following information for 
SAP R/3 instances on a selected node.

• hostname

• SAP R/3 System name

• SAP R/3 instance name/number

• SAP R/3 release number

• list of processes for the selected 
instance

Start R/3 Front-end Uses the local SAP gui utility 
(running on the OVO console) and 
profile to connect to the desired SAP 
R/3 system. 
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For example, launching the R/3 Info tool displays a window similar to 
the one illustrated in Figure 3. The Tool Status window indicates which 
command is being executed, on which node, and the command’s current 
status.

Figure 3 Output from the R/3 Info Tool

Status R/3 Config Displays a list of all SAP R/3 Systems 
(and the functional modules per 
System) present on the selected 
managed node. In addition, it lists all 
established SAP R/3 processes and 
indicates their current status.
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The Status R/3 Config tool is executed on the selected managed node 
and displays the current local R/3 configuration. It lists all SAP R/3 
systems installed on the selected node and the functional modules 
installed per SAP R/3 System. In addition, the R/3 process status provides 
a list of all established R/3 processes and their current status.

Figure 4 R/3 Configuration Status Window 
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Working with SAP R/3 Messages

The OVO Message Browser is the most important source of information 
about the status of the managed nodes for which you are responsible. If 
you are logged on to OVO as a user with SAP responsibilities, your 
Message Browser will include messages from SAP R/3 managed nodes.

Selecting and double-clicking a message in the Message Browser 
displays the selected message’s properties and allows you to:

• view a detailed description of a problem

• view instructions designed to help you solve the problem

• initiate a pre-defined action

• add an annotation to document your actions
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• acknowledge the message so that it is moved to the Acknowledged
Messages database

Figure 5 Message Details 

The example that follows shows a typical sequence of events when a 
critical message appears in the message browser. In this case, the message 
relates to a lack of free disc space reported by the opcmsg interface. 

1 In the Active Messages browser, double-click the message reported by 
the Smart Plug-in for mySAP.com. 

The OVO displays the message’s Text property sheet by 
default.
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2 Click the Instructions tab to see if any instructions have been provided 
to help you sort out the problem that has been reported.

3 Once you have read and understood the information provided in the 
Instructions tab, click the Commands tab to see if an automatic or an 
operator-initiated action is available to help solve the problem reported by 
the incoming message. In many cases, the SPI for SAP R/3 uses these 
actions to provide context-sensitive access to SAP R/3 and automatically 
displays the appropriate transaction window.

Figure 6 SAP R/3 Performance: Workload Analysis 

4 If an operator-initiated action is available, click the [Start] button in the 
Operator-initiated field of the Commands property sheet to launch it. 
You can watch the progress of the action in the Status field. In the 
message field, the action starts the SAP R/3 GUI and displays the 
Workload Analysis transaction illustrated in Figure 6. 

5 Click the [<server_name>] button indicated in the This application
Server field and use the tools available with SAP R/3 to solve the 
problem. 
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6 When you have finished, log out of SAP R/3 and return to the OVO 
Message Details window.

7 Click the [Acknowledge] button to confirm your awareness of the 
message to which you just responded. Once you have acknowledged the 
message, the message is moved from the Active Messages browser to 
the Acknowledged Messages browser.
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Removing the SPI for mySAP.com

This section provides information concerning the removal of SPI for 
mySAP.com software and any corresponding components.

Before You Begin

This section describes how to remove the SPI for mySAP.com software 
quickly and cleanly. You will need to perform the following tasks, as 
appropriate, on both the SAP R/3 managed node(s) and the OVO 
management server(s) on which you installed the SPI for mySAP.com 
software.

To remove the SPI for mySAP.com software, you will need to carry out the 
following high-level steps which are described in greater detail in the 
corresponding sections that follow:

• “Removing SAP R/3 Management Functionality from OVO Managed 
Nodes” on page 124

• “Removing mySAP.com from the OVO Management Server” on page 125
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Removing SAP R/3 Management Functionality 
from OVO Managed Nodes

To de-assign SAP management functionality from OVO managed nodes

1 On each managed node where you installed the SPI for mySAP.com Per-
formance Monitor, follow the corresponding deinstallation instructions in 
the chapter on the Performance Monitor.

2 Remove the SPI for mySAP.com policies from the SAP R/3 and ITS 
managed nodes. 

a In the OVO console tree, locate and expand the following policy group:

Policy Management > Policy Group > SPI for mySAP.com

b Select and right click the SAP SPI policy group and remove the 
policies by using the following option in the pull-down menu:

All tasks > Uninstall from...

c In the Uninstall Policies on... window which appears, select the 
managed nodes from which you want to remove the SPI for 
mySAP.com policies as illustrated in Figure 1 and click [OK].

Figure 1 Uninstalling SPI for mySAP.com Policies 
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d You can verify that the polices have indeed been removed from the 
SAP R/3 managed nodes by selecting the managed node in the console 
tree using the following option in the pull-down menu:

View > Policy Inventory

Removing mySAP.com from the OVO 
Management Server

To remove the mySAP.com software from OVO management server

1 Remove the SPI for mySAP.com software from the OVO management 
server as follows:

a Select the software to remove from your system using the standard 
windows Add/Remove Software window:

Start:Settings > Control Panel > Add/Remove Software

b The HP OpenView Operations Performance for Windows
InstallShield Wizard window which appears, select the software 
package you want to remove from your system. The HP OpenView 
Operations Performance for Windows InstallShield Wizard searches 
for products available for removal from your system.

c Select Next.
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d Select Remove selected products as illustrated in Figure 2 below .

Figure 2 Product Selection Uninstall screen

2 Select mySAP.com from the Product Selection Uninstall screen.

3 Follow the on screen instructions and select Finish when the product 
removal is complete.

4 In the OVO Console, remove manually any remaining SPI for mySAP.com 
GUI components, for example:

• the SPI for mySAP.com Tools group and its contents. You can find 
the SPI for mySAP.com Tools group in the console tree in the 
following location:

Operations Manager -> Tools 

• any ConfigFile policy types you have added

• any policy groups you have created.
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